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About the Author
Hello and welcome to Excel Campus!

Thank you for taking the time to sign up for my email newsletter.
My name is Jon Acampora and my goal is to help you improve your
Excel skills and save you time with your everyday tasks.

The blog at ExcelCampus.com is filled with articles and videos that
contain tips, techniques, and tools to help you learn Excel. | am
passionate about learning Excel and want to share that knowledge
with you.

| would like ExcelCampus.com to be a place where we can all learn :
from each other, so | encourage you to leave comments and give Microsoft’

me feedback. No question is too simple or silly, so please don’t R MVP Most Valuable
hesitate to ask. Professional

You can read more about me at excelcampus.com/about.

But enough about that, what's this book all about???

Introduction
How much time do you spend writing and editing formulas in Excel?

Most of us spend a lot of time working with formulas, and it’s not always easy. As you learn Excel, your
formulas tend to get more complex and time consuming to maintain. This is the nature of the Excel
beast. Excel can do some amazing formula calculations with unlimited potential, but this means it can
also get really complicated.

So | wrote this book to share some of the tricks and techniques | use to save time when working with
formulas. 1 like to find the fastest and most efficient ways to accomplish a task, and this books contains
10 in-depth techniques that will help make you more productive.

The tips in this book focus on Excel features, functions, keyboard shortcuts, and techniques that | use
every day. The book includes an Excel file that you can use to follow along and try these techniques.
The best way to learn is to put that knowledge to into practice immediately.

| have tried to make this book compatible for the Mac versions of Excel, !

and have listed the Mac equivalent keyboard shortcuts where applicable. ’

All the screenshots were taken in Excel 2013 for Windows, but these ‘ =
techniques will be compatible with versions back to Excel 2003. Wlndows + Mac Compatible

This list of tips will grow over time, and | would love to hear from you and get your thoughts. My
contact info is at the end of the book and please send me any tips or techniques that you use to save
time. 1 would love to learn them. Finding that “Ah-Ha” moment where the light bulb clicks on and you
learn something new is one of the most enjoyable moments with Excel.
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#1 AutoSum — Let Excel Write the Formulas for You
The SUM function is probably the one formula you use the most. And the fastest way to create a sum
formula is to have Excel do it for you.

FILE HOME INSEF‘?

% Cut X 2 AutoSum ~| A
Can
Em Copy -~ , J'Jat (%] Fill - zY [i

Paste Sort & Fir
¥ Format Painter T Clear~ Filter = Sel
Clipboard T Editing

The AutoSum button (located on the Home tab and Formulas in the Ribbon) will automatically create a
sum formula for a row or column of numbers. The button is only on the Formulas tab on the Mac.

Sum (Alt+=)

Autornatically add it up. Your total
will appear after the selected cells.

3
]
5
5

=sUM(J2:5)

To use AutoSum, simply select a blank cell below a column of numbers or to the right of a row of
numbers, then click the AutoSum button. That’s it! The sum formula will automatically be created.

You can also select all the cells in a row/column that contain numbers, then click the AutoSum button.
The sum formula will be created in the first blank cell directly below/adjacent to the selection.

The keyboard shortcut for AutoSum is Alt+= (hold down the Alt key, then press the “=" key). The
shortcut on the Mac is Command+Shift+T.

The keyboard shortcut is the fastest way to create sum formulas.

Use This Every Day!

AutoSum Keyboard Shortcut

Alt + =

10 Excel Pro Tips -3- Jon Acampora



AutoSum can create formulas in multiple cells at the same time.

Simply select a row of blank cells below your data and press Alt+=. The sum formulas will be created in
all of the blank selected cells that are below a column or to the right of a row of numbers. This makes
creating the formulas even faster. You don’t have to create a formula then copy it down/across.
AutoSum will do it all for you in one step, and save you tons of time!

Region a1l Q2 a3 Q4 Region Q1 Q2 Q3 a4
North 396 644 622 412 North 396 644 622 412
South 702 200 458 729 South 702 200 458 729
East 505 358 609 252 East 505 358 609 252
West 264 403 469 357 West 264 403 469 357
Total | | | | l- Total | 1,867 | 1,605 2,158 1,750 |

Select blank cells below Press Auto hutton o
columns of numbers. ) T R T

S Autos e Clicking the small drop-down arrow to the right of the AutoSum button
umD = iH gives you options to create formulas with other functions (Average,

2 Sum .4 Count, Min, Max).
Average s
Count Mumbers I}
Max
Min

=

Maore Functions...

Regio T Q17 Qi-| @i~ Q4| Total~

Advanced Tip: When a column of cells has a North § 396 544 622 12
filtered applied, using the AutoSum will create East E 505 358 609 252
a formula with the SUBTOTAL function instead west ! 2764 a03 169 157
of the SUM function. Th? §UBTOTAL function Total :;EII_EI;[-}TAL[Q,DZZ:DZEh
displays the sum of the visible cells only. It can mEITAL{functinn_num, refl [ref2], )
also be used for other functions such as

COUNT, MIN, MAX, AVERAGE, etc.

] ) Apply AutoSum to a filtered list to
Use function_num 1-11 to include manually generate the SUBTOTAL function

hidden rows, and 101-111 for filtered ranges.

Calculates sum of visible cells
only.
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#2 F2 & Escape Keys

Have you ever heard of someone removing the F1 key from their keyboard? It’s not uncommon for us
Excel junkies to want to do this, and some actually do remove the key.

Why? Well once a formula is written, you will probably spend a lot of time editing and modifying it.
This is especially true when you are working on someone else’s file and learning what their formulas
calculate.

The F2 and Escape keys on the keyboard can really save you time when auditing formulas.

Select any cell that contains a formula and press the F2 key to edit the formula. This opens the formula
for editing directly in the cell. The F2 equivalent on the Mac is Ctrl+U.

396
702

505
|l_2m -
=SUM(D5:08)

Press F2 to edit the formula

of the selected cell.

You can now use the left and right arrow keys on the keyboard to move the cursor and edit, add, or
delete text as needed. This means that you do NOT have to edit the formula in the formula bar that’s
located above the sheet. Instead, you can edit the formula in the cell, without having to use the mouse.

Region ! Color ! Sales

| |
MNorth Red 396
South Red 702
East _Blue ! 505
West IBlue | 264
W [l | C ] |
1,867
| | | |
ISouth  |Red =SUMIFS({D5:08,85:88,B11,C5:C7,C11)

Press F2 to quickly view

ranges that are referenced
in the formula.

Pressing the F2 key also allows you to quickly see what cells are being referenced in the formula. In the
example above my SUMIFS formula is returning an error. When | select the cell that contains the
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formula and press F2, colored boxes are drawn around all the ranges that are referenced in the formula.
| can quickly see that the green box (C5:C7) is not extending down the same amount of rows as the
other arguments in the formula.

The colored boxes around the ranges are extremely helpful when auditing formulas, and using the F2
key is the fastest way to show these boxes.

The Escape key exits the formula edit mode without changing the formula. This allows you to quickly
review the formula and its references with the F2 key, then press the Escape key if you do not want to
make changes.

Analysts frequently use the F2 and Escape keys when auditing financial models. And the poor F1 key,
which is stuck in the middle of these two, tends to get pressed accidentally. It can be frustrating
because the F1 key launches the help menu (slowly), and it can really slow you down when trying to
quickly navigate around a workbook. But don’t let that stop you from using F2 and Escape. These two
keys will save you a lot of time when analyzing your formulas.

#3 Quickly Add Multiple Cell References with the Control Key

Often times you will need to calculate the sum of a non-contiguous range. That is a range of cells that is
not joined together. The image below shows an example of this. | want to create a formula that sums
the Total rows for each product.

B C D
4 |Sales by Product a1
5 |Product A
il Orange 1,231
7 Blue 2,343
a8 Red 1,125
9 Product A Total 4,699 «—
10 |Product B
11 Green 563
12 Red 2,131
13 Product B Total 2,604
14 Product C 3,242
15 Orange 5,443
16 Red 432
17 Product C Total 9,117 &
18 | Grand Total !
19
20
n How do | quickly get the sum of
- the 3 product total rows?
73

The SUM formula for the Grand Total should be =SUM(C9,C13,C17).
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The problem is that typing this formula can take a long time, especially if you have a lot of subtotal rows
to sum up.

A quick way to create this formula is to hold down the Ctrl key on the keyboard, and select the cells you
want to include by left-clicking the cells with the mouse.

B C D
4 |Sales by Product a1
5 |Product A
] | Orange 1,231
7| Blue 2,343
8 | Red L1125
9 |Product A Total 1 4,699 _I«&
10 |Product B
11| Green 563
12 | Red l 2,131 L
13 |Product B Total 1 2,604 1&
14 |Product C
1 5_ Orange 5,443
16| Red a3
17 |ProductCTotal | 5,875 |«
18 | Grand Total =SUmM(C9,C13,C17
19| L
20
5 1— Hold the Ctrl key and select
g product total cells with the mouse
;:_ to quickly create a SUM formula.

Here's a step-by-step guide on this technique.

1. Type =SUM( in cell C18 to start the formula.

2. Hold down the Ctrl key on the keyboard.

3. Left-click cell C9 with the mouse.

4. Continue to keep the Ctrl key pressed down and left-click cell C13.

5. You will see that the formula now reads: =SUM(C9,C13

6. You can continue to left-click additional cells to add them to the formula.
7. When finished, close the formula with a parenthesis )

8. Click Enter on the keyboard to enter the formula.

This technique of holding the Ctrl key while selecting multiple cells or ranges to add to a formula will
surely save you some time when creating these types of formulas.

This feature is actually built in on the Mac 2011 version, so you won’t need to hold down the Ctrl key to
select multiple cells/ranges.

10 Excel Pro Tips -7- Jon Acampora



#4 Enter and Edit Modes Driving You Crazy?

Have you ever encountered this issue when you are editing a formula and you just wanted to move the
cursor left/right in the formula using the arrow key, but instead a new cell reference is inserted in the
formula? It can be very frustrating and usually leaves us wondering why it happens sometimes, but not
other times.

[ ——
1=IF(D10>0,"Yes",C12"No")

Hey that's not what | wanted!
Pressed the left arrow key and

Excel inserted a cell reference in
my formula... Argh!

This behavior is caused by the formula mode that Excel is in when you are editing the formula.
There are two different modes that Excel can be in when you are editing a formula: Edit & Enter.

Edit Mode — When you edit a formula, Excel defaults to Edit Mode. This means you can use the left and
right arrow keys on the keyboard to move the cursor within the formula and make changes.

Enter Mode — Enter mode is used for referencing cells or ranges in your formula. Clicking the arrow keys
on the keyboard will select cells in the worksheet and automatically add the reference of the selected
cell to your formula. This is the mode that can be annoying if you are just trying to move the cursor
within your formula.

The screenshots on the next page help explain this...
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The current mode is displayed in the bottom left corner of the Excel window. This will only appear when
you are editing a formula.

13

: e e The formula entry Mode is
1‘1] @ Yes',"No") displayed in the bottom right

15 corner of the Excel Window.
16
17
1 ... | 4. Enter Edit Mode (2) 4, Enter Edit Mode Shee

Pressing the F2 key will toggle between Edit and Enter modes, allowing you to control what happens
when you press the arrow keys. The F2 equivalent on the Mac is Ctrl+U.

12
= Pressing F2 on the keyboard will
14] :IF{D1D:={I: Yes’,"No }| toggle between Edit and Enter
15 modes.
16
17
4 ... | 4. Enter Edit Mode (2) 4. Enter Edit Mode She:

Edit Mode allows you to move the cursor in the formula with the arrow keys.

Enter Mode allows you to select cells/ranges and adds the references to the formulas when pressing the
arrow keys.

This entry mode applies to other features in Excel where you are prompted to select cells. You will
probably run into this problem when modifying the source data for a chart or PivotTable. The following
image shows the form that you use to select the data range for a chart.

)
14| Edit Series
1 N
16| | | =sDss:spsd
&
17
1 «. | 4. Enter Edit Mode (2) 4, Enter Edit Mo

Enter and Edit modes also apply to these types of forms, and it can be very helpful to know what mode
you are in when updating the range. Again, when you are in Enter Mode you can use the arrow keys to
selects the range of cells on the worksheet. Edit Mode allows you to move the cursor within the text
box.
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#5 The Function ScreenTip is Packed with Features

| am sure you have noticed this small box that appears below the formula bar or cell when you are
editing a formula.

[ ] [,
lSL'}Uth =VLOOKUP([C14,5855:5058,3,FALSE

VLOOKEUP(lookup_wvalue, table_array, col_index_num, [range_lockup])

The Screentip about the Function
appears below the formula when

editing a function witin the formula.

This is the Function ScreenTip for the function that you are currently editing, and it is actually quite
useful.

The argument in the function that you are currently editing will be displayed in bold in the ScreenTip.
This makes it easy to see exactly which argument you are editing.

| |
lSouth =VLOOKUP(C14,5855]5D58,3,FALSE)
VLOOKUP{lookup_value, table_array, col_index_nurn, [range_lookup])

The argument you are currently

editing will be bolded in the
screentip.

You can click on any of the arguments within the ScreenTip to select the text of that argument.

| |
lSouth =VLOOKUP(C14,5B55:5058,3,FALSE)
VLOOKUP{lookup_value, table ar% col_index_num, [range_lockup])

Click on any argument in the
screentip to select the text of that

argument in the formula.

This makes it very easy to then change or delete the reference. In the example image above, if | want to
change the “table_array” reference in the VLOOKUP function, | can click “table_array” in the ScreenTip
with my mouse and the corresponding text in the formula will be selected. Then | can select cells in the
worksheet to change and replace that reference (SB$5:5DS$8). It is much faster than trying to select the
text using the mouse cursor, especially with long formulas that reference other sheets.
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The ScreenTip link can also be used to quickly change a cell reference to absolute or relative when used
with the F4 key. Here’s a quick guide on how to change this A2:A5 to SAS$2:SASS5.

1. Click the ScreenTip argument link to select the text.
2. Press the F4 key on the keyboard to change the reference to absolute. This adds the $ symbol in
front of the column letter and row number to anchor the reference.

That’s it!

The F4 key (Command+T on Mac) toggles references between relative and absolute. If you select the
entire range reference, both cell addresses on either side of the colon : will be updated. That is where
the ScreenTip link comes in handy.

The following is quick guide on how the references will change when the F4 key is presses. It is
important to note that for the F4 key to work, the cursor must be placed inside the reference or the cell
reference must be selected.

Guide to Relative & Absolute References with the F4 Key

=SUM(A2:AS) <-Relative Reference

=SUM(SASZ:5A55)  |<-press F4 Once - Absolute Reference

=SUM[AS2:AS5) <-Press F4 Twice - Relative Columns & Absolute Rows

=SUM[SA2:5A5) <-Press F4 3rd Time - Relative Rows & Absolute Columns

Clicking on the Function name in the ScreenTip will launch the help menu for that function. The image
below shows an example of this. This is a quick way to learn more about the functions you are using.

Region Color Sales
Morth Red 396 Exce| He| p -
South Red 702 }
— Blue 505 © S A | Search online help
West Blue 264
1,367 VLOOKUP function
South Red 702 This article describes the formula syntax and u:

VLOOKUP function in Microsoft Excel.

ISouth  |=VLOOKUP| Gu#¥BS5:5D55,3,FALSE) Description
OOKUP{lockup_value, table_array, col_index_n

You can use the VLOOKUP function to search 1
column of a range of cells, and then return a v
any cell on the same row of the range. For exar
suppose that you have a list of employees conf
the range A2:C10. The employees’ ID numbers
in the first column of the range, as shown in th
illustration.

Click the function name to launch the

help menu for the function.
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And finally, if the ScreenTip is in your way, you can move it!

[ |
lSDuth =VLOOKUP({C14,5655:5058,3,FALSE)

O0KUP{lookup_value, table_array, col_index_num, [range_lockup])

Move the screentip with the mouse.

Hover the mouse over the left side of the ScreenTip until the cursor changes to the cross arrows. Left-
click and hold and drag it to a new location. Sometimes it is nice to move the ScreenTip out of the way if
your formula is long and wrapping underneath it.

#6 Quickly Jump To a Cell or Range Reference

If you spend time navigating through your workbook to find a cell or range reference that is on another
worksheet, this tip will save you a lot of time.

1 |
Isouth —VLOOKUP(C6, Datal$AS2:8CS5| 3, FALSE)

This reference is on another sheet.

How do | guickly get to that sheet?

You can use a combination of the ScreenTip and the Go To menu to quickly navigate to a cell or range
that is referenced in a formula.

The image below shows the three-step process that will jump you right to the range that is referenced in
the VLOOKUP formula. From there you can quickly view and change the range in the formula.
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2. Press F5 on the Keyboard to
open the Go To Menu.

The range reference is
automatically copied into
the Refernce box.

Reference:

3. Press OK to Go To the S
worksheet that contains the i [ p V\J [ PR ]

reference.

The F5 key (Ctrl+G on Mac) on the keyboard is the shortcut to the Go To menu.

After pressing OK on the Go To menu, the sheet in the reference (Data) will be activated and the range
will be selected. You can now make changes to the range.

A B C E F G H

1 [Region|-|Color -] sales |
2 INorth Red 396 |
3 |South Red 702 i You will jump to the
4 |East Blue 505 1 'Data’ sheet. The range
5 West  Blue 264 1 is highlighted and you
6 [south Red 702 can change it if needed.
7 |East Blue 702
8 |South Red 02
9 |East Blue 702,
10 | YVLOOKUP{lockup_value, table_array, col_index_nurn, [range_lookup]) |
11

« » .| Data | Sheetl3 ... P[] | D

This technique will help you quickly navigate through your workbook. You won’t have to waste time
scrolling through worksheets to find the ranges that are referenced in your formulas.
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#7 The Functions Argument Window is Your Friend

The Functions Argument Window will provide you with a lot of detailed information about a function in
your formula. It can save you time when trying to evaluate a formula to see what is included in it.

The keyboard shortcut Shift+F3 (Ctrl+A on Mac). is the quickest way to open the window. You can also
click the formula icon to the left of the formula bar.

Jx || =SUMIFS(E6:E9,C6:C9,C12,D6:D9,D12)
P
e

Keyboard shortcut: Shift+F3 opens
the Functions Arguments Window.

The Function Arguments Window displays an organized list of all the arguments in the function. This
makes it easy to see the components of the function, especially with longer functions like the SUMIFS
function in the image below.

Jx =SUMIFS(E6:E9,C6:C9,C12,D6:09,D12)

. Functicn Arguments

V SUMIFS
Sum_range | EG:E9 FRz| = [396:702:505;264} -
Criteria_rangel | Ch:C9 FRz| = ["MNorth™"South™"East™ West’]} D
Criterial | C12 E%i| = "south
Criteria_range? | Dé:09 F&z| = ["Red""Red” Blue”"Blue?}
Criteria2 | D12 S| = “Red
" Organized list of the
Adds the dglls specified by a given set of conditions or criteria. 2 that diSplaﬁ

the values in each range.

Sum_range: are the actual cells to sum.

Definition of the selected argument.
Formula result = 702
Result of the formula.
Help on this function l OK I [ Cancel

The values within each argument are displayed on the right side of the window. This makes it easy to
see exactly what is included in you formula. You can see that the formula is summing column E for the
South region and Red color.

The window also displays the definition of the selected argument. This is helpful when you are learning
the functions and not exactly sure what is required for each argument of the function. The definition
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will provide some basic information, and you can click on the “Help on this function” link in the bottom-
left corner to open the full help menu.

As your formulas start to get longer and more complex, the Function Arguments Window is a good place
to view the formula in a way that won’t make your head spin. It is much easier to look at than a long
string of text.

Note: Excel for Mac has a different version of the Function Arguments window. It is called the Formula
Builder. It is laid out a little differently than what you see on the images above, but it has the same basic
features and should be useful.

#8 Expand the Formula Bar

Speaking of long formulas... When your formula gets really long, you can increase the height of the
Formula Bar. This is just a quick tip, but it can be really helpful when viewing long formulas.

>~ "4 J =IF{C7="Y¥es",IFERROR(VLOOKUP(C&,Datal SAS2:5C55,3,FALSE), SUMIFS('2. F2 & -~
Escape'!5D$4:5D57,'8. Formula Bar Size'!C8,'2. F2 & Escape'!$B54:B7,'8. Formula Bar
Size'lB8,'2. F2 & Escape'l5CS4:5C57) | ,CHOOSE(B7,"One","Two","Three"])

o jt This button or Ctr+Shift+U will

Expand the height of the Formula
bar for long formulas.

expand and collapse the bar.

In the image above | have a long formula (that is complete non-sense). | can increase the height of the
formula bar to view the entire formula by hovering the mouse over the bottom of the formula bar until
the cursor changes to vertical arrows. Then left-click and drag the bar down to make it taller.

The keyboard shortcut Ctrl+Shift+U (same on the Mac) will automatically expand/collapse the formula
bar to the extended height that you have set it at. This keyboard shortcut is especially useful if you are
working on a laptop and you want to view as much of the grid as possible. It allows you to quickly
collapse the formula bar when you’re not working on a long formula.
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#9 [@[Structured References]:[Time Saver]]

Do you use Excel Tables? You know, the colorful tables that look like the following.

A B c D |
3

-
3 MNorth Red 396

6 South Red 702

7 East Blue 505

2 West Blue 264

9 | Total 1,867 |
10

Ex]

Well don’t worry if you have not used Tables. They are a new/improved feature to Excel 2007 (Excel
2011 for Mac), but they have not become too popular, yet.

Tables were designed to save you time when working with your data, and | believe they do really great
job of it. What were once time consuming tasks like styling, sorting, filtering, summarizing and
rearranging your data, now become extremely quick and easy with Tables.

| have created a video on 10 Awesome Features of Tables that | recommend you watch to learn more
about them.

One feature of the Tables is a new formula syntax called Structured References.

As you can see in the image below, the structured reference syntax uses column names instead of cell
addresses. If this cell was NOT in a table the formula would read =E5/D5

A B C D E F G

3

.3l Region B color B sales B profit B marginkd

5 Morth Red 396 25|=[@Profitlf[@s5ales]
6 | |South Red 702 134 19%)|

¥ Fact Blia Sns :

Structured Reference formula

syntax with Tables.

The formula that uses structured references in the Table is much different. Instead, it uses the names of
the columns in the formula. This makes formulas much easier to read and write.

And this is especially true when the table is located on a different sheet. The formulas are much easier
to write because you do NOT have to include the sheet name. Formula writing becomes much more
intuitive and Tables will definitely save you time.
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| =5UM|DataTable[Sales] }l

The Data Table referenced in this
formula is on a different sheet.

This formula can easily be written
without having to navigate to the
sheet that contains the Data Table

This does require you to learn a new way to reference cells and ranges in your formulas, and | know
some people aren’t comfortable with the new style right away. It does take some getting used to, but
there are many great time saving benefits to using tables.

An entire book could be written on this topic, but | encourage you to checkout my Tables video and
learn more about them.

#10 Trace Before You Delete

Have you ever wanted to delete an entire sheet, but you’re not sure what formulas depend on it and
don’t want your model to blow up? This is a common problem, especially when you are inheriting a
model from someone else and you are not familiar with how it was built.

The Trace Dependents feature can be your savior here. Before you delete the sheet, you will want to
trace the dependents of cells that might be used by other sheets in the workbook. For example, let’s
say you have a VLOOKUP formula on ‘Sheet1’ that references the ‘Data’ sheet.

=VLOOKUP(A1,Data!$B$2:5D$100,2,False)
If you delete the ‘Data’ sheet then this formula on ‘Sheet 1’ will return an error.

To prevent this you will want to trace the dependent formulas of the cells on the ‘Data’ sheet to see
what formulas rely on them.

Select a cell that might possibly contain references in a formula on another sheet, then press the Trace
Dependents button on the Formulas tab in the ribbon.

FORMULAS DATA REw. “WER QUERY

I \Em %25 Trace Precedents % Show Formulas

ﬂﬂE Trace Dependents 1 Error Chec king -
wt Date & Lookup & Math & [, .
Time - Reference~ Trig= Fu tion  [% Remove Affows - (%) Evaluate Formula

rary b Formula Auditing
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The keyboard shortcut for Trace Dependents is Alt+T+U+D (Ctrl+] on Mac). That’s old school Excel 2003,
but still works in current versions.

If the Trace Dependents function finds any formulas in other sheets that depend on the selected
formula, then a dashed arrow will appear with a spreadsheet icon at the end of it. See the image below.

A B D E F
1 |Region|~|Color |~ -
2 |Morth Red
3 |South Red 52|
4 |East
3 |West
6 |South Double left-click on the dashed line to
7 |East open the Go To box to view the cells
8 |South that contain dependent formulas
9 |East
10
11
12
13

1A

H I J K

L@ [ )

GoTo

Go to:
‘[Tips for Writing Formulas.xlsx]6. Go To Referen -

'[Mips for Writing Formulas SCREENSHOTS. xlsx]8.

Reference:
‘[Tips for Writing Formulas.xlsx]3, Formula Bar Size’

Special... ] [ OK ]l Cancel

This spreadsheet icon indicates that there is a dependent formula in another worksheet or workbook.
Double-click on the black arrow line and the Go To box will appear. You have to make sure you click on
the black dashed line between the selected cell and the spreadsheet icon to get the Go To box to
appear. It’'s not always easy to do.

Once the Go To box is open you can double click on any of the entries in the list to Go To that specific
cell. Then you will want to review this formula to see if it is still needed, since you will be deleting the
sheet that it depends on.

The keyboard shortcut to remove the trace arrows is Alt+T+U+A. And Alt+T+U+T (Ctrl+[ on Mac) traces
precedents. Alt+T+U+F will open the Evaluate Formula Window. That window is a topic for another
discussion, but | wanted to give you all the old school Alt+T+U+... shortcuts that | use.
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Conclusion

Well | really hope that you found some useful tips from those 10 techniques. There is always something
new to learn with Excel, and | believe that is what makes it fun and challenging to work with.

| encourage you to continue learn more about formulas and functions. One great way to do this is to
learn a new function every day. Go to the Formulas tab in the ribbon, click on any of the Function drop-
down buttons, hover the mouse over a function you are not familiar with, and press F1 on the keyboard
to launch the help menu for the function and read about it. You’ll be amazed at what you learn!

HOME INSERT PAGE LAYOUT FORMULAS DATA REVIEW VIE

> BiS EDE &’ &

AutoSum Recently Financial Logical Text Date & Lookup & Math &  More |

- Used - = M *  Time~ Reference~ Trig= Functions~ M
ACCRINT -
- ACCRINTM
AMORDEGRI
B ACCRINTM(issue, settlement, rate,par, basis)
AMORLINC
_l Returns the accrued interest for a security
— COUPDAYBS  that pays interest at maturity.
COUPDAYS

a Tell me more
COUPDAYSMC

So there’s tip #11 — Learn a new function every day.

Share

Please feel free to send this eBook to a friend. It is a free gift from me, and my goal is to help
you improve your Excel skills and save you time with your everyday tasks.

If you are receiving this from a friend, please sign up for my free email newsletter to receive more great
tips and techniques like these.

Thanks again for your support!

Jon Acampora
Excel Campus | jon@excelcampus.com | excelcampus.com
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